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INTRODUCTION  
 
 
 For the past 40 years digital computers have literally been changing the face of our civilization, 
and with it the means and methods of the engineering field.  They introduced themselves at first to 
the scientific and accounting fields as number crunchers, in a short while they conquered the data 
filing/processing sector, and finally penetrated every place humans work and live, redefining all the 
areas they came in contact with.  Their presence and effects can be found today in every place, be it 
an administrative office, a factory high bay area, a living room, or even a car and a plane.  Yet their 
power and impact to the society would have been much more limited in size and intensity, were it 
not for the invention of the Integrated Circuit (IC) and it's brain child, the Microprocessor. 
 
 Its use revolutionized the industrial automation and control providing the average user with 
inexpensive processing power previously available only through mainframe computing.  Its 
miniature size, low cost and power requirements, combined with is fast execution speed and accuracy 
opened vast new application areas to data acquisition and process control.  Every-day applications 
where microprocessors are used as controllers, in place of their now extinct analog predecessors, 
range from sophisticated robot manipulators and vision systems, to fuel and navigation control in 
automobiles and planes, chemical processes, machine tools, medical equipment, microwave ovens 
and practically all today's home electronic appliances.  But by far the most common use of the 
microprocessors is as central processing units (CPU) inside the microcomputers.  Combined with 
powerful peripherals and connected in networks these "desktop" computers successfully rival 
yesterday's "dinosaurs" costing orders of magnitude more.  Areas like digital signal processing, 
imaging and computer vision, controls and robotics, all the more migrate from the old mainframe 
type processing, and depend on fast (CISC or RISC) microcomputers to execute their task accurately 
and safely.  
 
 The purpose of this experiment, and the Computer Applications Laboratory in general, is to give 
the student a taste of the challenges involved in using microcomputers as controllers in real life 
applications.  It does so by implementing well known and important theoretical results from the 
areas of Automatic Control and Signal Processing into a set of experiments, where the 
microcomputer with the use of peripheral devices, collects data from the process, processes it, and 
returns useful information back to the process and reports to the supervisor if necessary. 
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EXPERIMENT OVERVIEW 
 
 
 This introductory experiment covers the basic architecture of a microcomputer and the 
digitization of analog signals for processing.  The purpose of this experiment is to introduce the 
student to the microprocessor and its I/O devices and to give him/her a feel for its capabilities and its 
limitations.  The introductory programs provided have been designed to demonstrate access to the 
I/O devices available at the lab bench, and to illustrate some of the features of I/O programming 
using the Pentium PC for such a task.  Each lab bench has its own dedicated computer and 
supporting software and equipment. 
 
 The lab experiment is divided into the following sections: 

Microcomputer overview.  Here basic information on microcomputer architecture and 
data acquisition system components are briefly reviewed. 
Part I.  Consists of a set of pre-programmed signal processing functions to be observed and 
analyzed.  This part serves to demonstrate how the hardware is accessed, and how data is 
retrieved, processed, and returned back to the application. 
Part II.  A set of functions the student must write or modify that use some of the I/O devices 
including the keyboard, VGA display, A/D and D/A converters. 

 
 All programs in parts I and II are to be compiled and run using the Microsoft QuickC V.2.0 
interactive environment available on the lab computer.  This is an integrated development 
environment where the user can edit, compile and interactively run/debug standard ANSI C 
programs.  More details on how to use QuickC follow in the relevant sections. 
 
 It's expected that the student comes prepared for the labs, having read the lab 
procedures, necessary references, and anticipated some of the results before coming to 
lab.  Copies of the programs are also available for anyone desiring further information.  It is highly 
recommended that you take useful notes.  Feel free to ask questions, as the information presented in 
this lab will be needed in the future when you use the system.  In the beginning, emphasis should be 
placed on the procedures to be followed rather than on the programs themselves.  As you progress, 
you can go back and study the programs so that you can see the procedures as a logical sequence 
rather than frustrating cookbook instructions.  The instructor will also point out where the reference 
material on the system is located.  Note the limitations of the I/O devices as they are discussed.  The 
limitations are important since some of the devices can easily be destroyed if the limitations are 
exceeded! 
 
 The programs that are used to implement the various filters have been supplied.  It is your job to 
input and monitor some of the parameters of the process through the I/O devices at each lab bench.  
Some of these parameters will be varied and you will see how the variations will affect the processes.  
Later, you may write some of your own programs during the project portion of the lab. 
 
 During the course of the lab, it is hoped that you will discover that the microcomputer is an 
important, versatile and indispensable tool in the electrical engineering field.  The applications of 
the microcomputer are endless and perhaps only limited by the engineer's imagination.   
 
 
 
MICROCOMPUTER ARCHITECTURE SUMMARY 
 
 
 Microcomputers vary significantly in processing power and general capabilities depending on the 
components they are built of.  Yet in general they all consist of the same structural blocks, 
summarized below: 
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CPU It is the most important and complex component as mentioned at the beginning.  It's 
implemented as a VLSI chip and more than one microprocessors may act as Central 
Processing Units.  Its basic architecture consists of storage elements called registers 
where data is stored for fast retrieval, computational circuits designated as arithmetic-
logic units (ALUs) where all standard integer arithmetic, logical and string operations 
take place, the control and timing block responsible for synchronizing data transfers, and 
the input-output block responsible for communicating with the outside devices.  Useful 
extensions include the memory management block, for manipulation of the external 
memory, floating point math coprocessor, cache memory for fast storage of the next data 
to be processed, or other specialized function blocks. 

  The CPU selects the peripherals to "talk" to, using the address bus, a set of wires 
carrying uniquely identifying signal combinations, and exchanges information through 
the data bus.  Its task consists of fetching the control instructions, decoding, interpreting 
and carrying them out.   

  CPUs are classified as 8bit, 16bit, 32bit (64bit to come) depending on the size of their 
registers and data bus, or as CISC, RISC depending on the instruction capabilities, or 
general and specialized (graphics, math, signal/image processing). 

 
RAM Random Access Memory is the main memory of the system where programs and data are 

stored.  Also known as read/write memory, all its information is lost when the computer 
is turned off.  RAM is realized using semiconductor flip-flops whereby binary information 
is stored in the state of the transistor flip-flop circuits. 

  Its building structure depends on the CPU type, and its major drawback (in dynamic 
RAM) is that it needs regular refreshing in order not to lose data.  All information is 
processed in binary (1/0) form and represented inside the computer using signed 2's 
complement representation. 

 
ROM Read Only Memory is used for storing permanent information.  Only readable and non-

volatile, its common use is to boot up the computer and load the operating system to take 
over.  Data stored in it, may include routines to be used to access other hardware like the 
screen and the keyboard. 

 
Keyboard Used to transmit information from the user (human) to the computer. 
 
Video I/O Monitor combined with the video controller card and used to return information to 

human understandable form as drawings (colored or not) and characters.  Uses it's own 
RAM and since it takes considerable time to prepare the information, dedicated CPUs 
are often used. 

 
Storage Included are floppy disks, hard disks and backup tape drives, and are used to 

permanently store information.  Readable and writable (normally) devices employ 
magnetic flux technologies to transfer information to and from properly coated surfaces.  
It's currently the main type of storage with optical technologies on the way.  Support 
both random and sequential information access (tapes normally are sequential only). 

 
Others Hard copy devices include dot matrix and laser technology printers and plotters.  Input 

devices include mice, digitizers or other specialized hardware. 
 
Software The "magic touch" that transforms the piece of silicon into an "intelligently thinking and 

acting" device.  Consists of the firmware very low level I/O, the operating system giving 
access to all the computer resources in an orderly manner, and the high level 
applications that execute a specific task. 

 
A/D D/A  Devices that allow the microcomputer (an inherently discrete device) to communicate  
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Boards with the analog (continuous) world outside.  The A/D converter samples the input 
voltage and converts it to a binary number that the computer can use.  Because of the 
discrete nature of binary numbers and limitations on the size of the numbers handled, 
the converter will convert a specified range of voltages to one binary number 
(quantization error).  Other limitations of the device include the conversion time and an 
effect known as quantization noise.   

  The D/A converter does the opposite, in other words it converts a binary number to an 
equivalent voltage.  D/A converters also have a specified conversion time and also 
produce quantization noise.   

 
 It is hoped that the above few lines serve only as a review to the student, otherwise extensive 
reading of any introductory Microprocessor book is strongly advised. 
 
 
 
LAB HARDWARE & SOFTWARE DESCRIPTION 
 
 
 The PC used for the lab is an HP Vectra computer.  The CPU is an Intel Pentium 32-bit 
processor running at 166 MHz.  It is equipped with 32 Mbytes of RAM, a 1.44 MByte 3.5" floppy 
drive addressed as A:, a CD ROM drive addressed as D:, a 1.2 GByte hard disk addressed as C:, a 
Video Graphics Adapter, and a networked printer.   
 
 For data acquisition and control purposes the PC is equipped with an RTI-815-A Multifunction 
Analog/Digital Board built by Analog Devices.  The board has a resolution of 12 bits.  Only a fraction 
of its available options are used during the labs.  Three A/D and two D/A ports are currently 
accessible to the user.  Their range is ±10V with a resolution of 4.883 mV.  The board is configured to 
process the data in 2's complement format, thus bit 11 is used as a sign bit duplicated throughout 
the rest of the second byte during A/D conversions.  For example a +5.000V signal is read and 
written as 0x0400 while a -5.000V is read as 0xFC00 but should be written as 0x0C00.  Similarly -
10.000V is read as 0xF800 but should be written as 0x0800.  A list of the manufacturer's 
specifications follows: 
 
ANALOG INPUT SPECIFICATIONS 
Analog Input Channels: 8 differential, 16 single ended (3 set up for the Lab) 
Analog Input Voltage: ±10 volts full scale 
Analog Input Impedance: > 108 ohms 
Digital Output: 12 bits including sign 
Coding: 2's complement 
Resolution: 4.883 mV 
Overall Accuracy (% full scale ±1 LSB): ±4.883 mV 
Differential Linearity (% full scale 
 variation in state size ±1/2 LSB): ±2.442 mV 
Conversion Time: 12µs  
 
ANALOG OUTPUT SPECIFICATIONS 
Analog Output Channels: 2 (2 set up for the Lab) 
Digital Input: 12 bits including sign 
Coding: 2's complement 
Analog Output: 10 volts full scale 
Output protection: Short-to-ground, continuous 
Resolution: 4.883 mV 
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Differential Linearity (% of full scale 
 variation in state size): ±1LSB max 
Overall Accuracy (% of full scale  1/2 LSB): ±0.02% 
Output Settling Time: 20µs for full scale execution 
 
EXPLANATION OF TERMS USED IN SPECIFICATIONS 
Converter Speed: The time required to convert input to output to within a finite error (per 

bit). 
Differential Linearity: Given here as the percent of change in the slope between two subsequent 

(analog) samples. 
Impedance: The total opposition (i.e., resistance and reactance) a circuit offers to the 

flow of alternating current.  The higher the impedance the less 'loading' 
effect the device will have on a parallel circuit. 

Multiplexer Settle Time: The time required for the processor to access different converters on the 
same channel. 

Overall Accuracy: The maximum error in the measurement of the input in terms of the 
output at full scale, ±10 volts. (LSB - Least Significant Bit). 

Resolution: The degree to which nearly equal values of a quantity can be 
discriminated.  A measure of the smallest possible increment of change in 
the variable input or output of a device. 

Two's Complement: The two's complement of a positive number is formed by complementing 
(changing ones to zeros and zeros to ones) the bit string and adding 1 to 
the least significant digit, executing all required carries.  This is the 
model all computers use for storing and processing arithmetic 
information.  TABLE 1. is a mapping between the voltages supported by 
the A/D converters and their 2's complement representation. 

 
Voltage Binary Value Decimal Value 

+9.995117  0000 0111 1111 1111  +2047 
+9.990234  0000 0111 1111 1110  +2046 

.   .  . 
+5.000000  0000 0100 0000 0000  +1024 

.   .  . 
+0.014648  0000 0000 0000 0011  +3 
+0.009766  0000 0000 0000 0010  +2 
+0.004883  0000 0000 0000 0001  +1 

0.000000  0000 0000 0000 0000  0 
-0.004883  1111 1111 1111 1111  -1 
-0.009766  1111 1111 1111 1110  -2 
-0.014648  1111 1111 1111 1101  -3 

.   .  . 
-5.000000  1111 1100 0000 0000  -1024 

.   .  . 
-9.990234  1111 1000 0000 0010  -2046 
-9.995117  1111 1000 0000 0001  -2047 

-10.000000  1111 1000 0000 0000  -2048 
  ↑ ↑ 
Sign Extension from 11 to 15 bits   11th bit sign (0 · +; 1 · -) 

 
TABLE 1.  A/D & D/A 2's complement conversion scheme. 
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ELEMENTARY DIGITAL DATA CONVERSION NOTIONS 
 
 
 As mentioned before, the microcomputer is using A/D and D/A converters to collect analog data 
from real world processes, convert it into binary form, process it extracting useful information, and 
convert it back to analog form and make it available for the processes to use.  FIG. 1 shows the basic 
steps of such a cycle in the simple digital transmission of an analog signal x(t) using a zero order 
hold D/A converter. 
 

 
 

FIGURE 1.  Digital sampling of a typical signal x(t). 
 
 
 The analog input signal x(t) at X is sampled at discrete intervals of time by closing the switch 
labeled A.  The A/D converter at B converts each measurement into a string of binary digits of 
predefined length, indicating the amplitude of the signal at that instant.  For example, an amplitude 
of +7 volts would correspond to the message 0111.  Notice that the resolution of the conversion in 
FIG. 1 is only four bits.  These binary strings are processed by Medium C and the result is 
introduced to a D/A converter which creates the staircase constant signal y(t) at Y, equal to the 
amplitude of the sampled signal.  The fact that the string patterns before and after the medium are 
the same purely depends on what the Medium C does to the data.  Still in this case if the signal y(t) 
is put through a low pass filter, the resulting waveform might be a fair duplication of the input 
signal x(t). 
 
 When the input at X is a voice or other audio signal, two major factors govern whether or not the 
output at Y will be an intelligible signal. 
 a) The number of bits used to describe the magnitude of the signal, N. 
 b) The rate at which the signal is sampled, R. 
 
 The number of bits used sets a limit on how accurately the analog signal may be measured.  If 
only one bit were used, the output at Y would take on only two values, say ±10 volts.  However, if ten 
bits were used, the amplitude at Y would match the input at X to one part in 210 or less than .1% 
error. 
 
 The rate at which the signal is sampled must somehow be related to the maximum frequency of 
the input signal.  If an input was sampled at a rate less than the highest frequency, much of the 
information in the input signal will be lost.  It can be shown that a suitable lower bound on the 
sample rate is twice the maximum frequency. 
 
 The bit rate for a sampled signal is given by the expression: C = N * R (bits/second).  The quality 
of the output is affected by the bit rate because of its dependence on N and R.  In what fashion does 
the bit rate affect the quality?  
 
 Since a higher bit rate requires a more complicated transmission medium, designers of such 
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systems are interested in getting the lowest possible bit rate which will result in an intelligible 
output at the receiving end.  One such method is to notice that although the human ear can hear 
sounds in the frequency range 20-20,000 Hertz, normal speech frequencies lie below 3500 Hertz.  
Thus filtering a voice signal to within this range of frequency will achieve good results.  This 
observation has allowed sample rates to be reduced from 40,000 samples/second to 7,000 
samples/second, which corresponds to 84,000 bits/second for a system with 12 bits resolution. 
 
 Many signals can be processed together through the method of Time Division Multiplexing 
(TDM).  This is somewhat similar to computer time sharing.  The computer processor internally 
cycles to service each user at such a rate that it seems to be servicing all simultaneously.  Any data 
flow that occurs during the interval that a user is not being polled, is retained or buffered, until the 
next cycle.  To implement Time Division Multiplexing, all information is time sliced on a single 
rather than several transmission media. 
 
 
INTRODUCTION TO PROGRAMMING WITH MICROSOFT QuickC 
 
 This section contains a brief introduction to using the Microsoft QuickC interactive environment.  
It assumes no knowledge of C (even though experience in a programming language is necessary), and 
it doesn't pretend to be a tutorial either of the language itself or the environment.  For more 
information it's suggested that the user run the "Learn Quick C" option (follow included instructions) 
and use the Help function extensively.  Also the programming style in the programs included is as 
simple and intuitive as possible, rather than trying to teach programming elegance.  To start using 
the PC, turn it on (if off) and while it is booting up – just after the ‘Starting Windows 95’ message, 
hit the <F8> key.  Choose ‘COMMAND PROMPT ONLY” (option 6) in the list.  At the DOS prompt 
type: CD C:\Cstudio\CAL_LAB\INTRO. 
 
 QuickC is started at the DOS prompt by typing QC (or QC/h for 43 lines/screen).  It uses a very 
typical visual editor employing the cursor keys, Insert, etc.  The function keys are used extensively, 
both in editing and in compiling/debugging.  Table 2. summarizes their usage. 
 
Key Alone Shift Ctrl Alt Shift + Ctrl 
F1 Help Help on Help Next topic Previous topic Previous hyperlink 
F2 Last file — — — — 
F3 Repeat search Next error — — — 
F4 View output Previous error Close window Exit — 
F5 Run Restart — — — 
F6 Next window Previous window Shared window — — 
F7 Continue to — — — — 
F8 Trace into Previous history Size window — — 
F9 Toggle breakpt — — — — 
F10 Step over Next history Maximize window — — 

 
TABLE 2.  QuickC function key assignment. 

 
 The Help (F1) function is context sensitive and contains information about literally every aspect 
of the language and the environment.  Typical ways to access it are: 
 • With the cursor at the beginning of the word to get info for, press F1.  If it is part of the 
language (keyword, identifier, error code, etc.), the help menu at the top pops-up with a summary.  If 
other options are included in brackets (typically <Description> and <Example>), use the cursors 
or the TAB & SHIFT-TAB keys to select them, and Enter to open them.  Travel backwards the 
same way, or press ESC to exit. 
 • From the Help menu select the Index option.  This accesses all topics covered, in alphabetical 
order.  Move to the starting character wanted and press Enter.  A list of all topics starting with the 
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selected character appears, so move to the desired keyword and press Enter.  From there on follow 
the previous instructions. 
 • From the Help menu select the Contents option.  All the categories where help might ever be 
wanted (even editing and Function Key usage is included) are there.  Move to the category that you 
think will logically include the action you are looking, and press Enter.  All the members or this 
category are displayed (unless it contains subcategories), and you can pick the one wanted as before.  
From there on follow the previous instructions.  This method is particularly powerful if the user 
wants to know what functions deal with a specific task, or simply to see the C identifiers or the 
editing keys. 
 
 The menu bar functions located at the top may be accessed as follows: Hit/release the Alt so that 
the menu list is highlighted; move left-right through the menu list using the cursor keys until the 
desired pull-down menu is highlighted, and press Enter to open it; move up-down through the 
function list, and press Enter to select the highlighted function.  If further selection is necessary, 
follow the same method.  Should data entry be required, use TAB and SHIFT-TAB to move around 
the various fields and the editing keys to fill in the gaps. 
 
 Most of the menu functions duplicate function key combinations and are beyond the scope of the 
simple edit/run that this lab requires, thus only scattered functions will be noted in the following: 

• In the Options menu make sure that Full Menus option is selected (with a *).  The Make 
options should have been configured by the TA. 
• In the Utility menu select the Learn QuickC option for an hour tour around the 
environment. 
• The File, Edit, and Search menus facilitate regular editing. 
• In the View menu the Windows option allows simultaneous text windows to appear on the 
screen.  Very useful windows are the Notepad for cutting and pasting and the Debug 
window.  The latter one allows regular editing and is very useful for observing variables 
during debugging.  To switch around the windows, use the F6 key. 
• In the Make menu Compile option only compiles where Build compiles and links.  No make 
files are necessary during this lab. 
• In the Run menu Run duplicates F5, and Restart option is necessary every time the same 
program is to be re-executed. 
• In the Debug menu Breakpts and Watchpts facilitate debugging but are not expected to be 
used during this lab. 

 
 Note that you don't have to master all the above features in order to successfully run the 
experiments.  Probably the easiest way is to re-edit the programs supplied.  When done editing the 
program, function key F5 starts the compiler.  If it detects any errors, the source line containing the 
error is highlighted and on the error menu a brief description appears.  The combination SHIFT-F3 
will take you to the next error each time it is hit.  After a successful compilation, hitting F5 will also 
execute the program.  QuickC is exited by the Exit function under the File menu.  You may save 
your program first with the Save command in the same menu. 
 
 
SAMPLE I/O PROGRAMS 
 
 The following sample programs demonstrate basic I/O functions necessary for this lab. 
 
• A/D Converter.  This program provides conversion of a bipolar signal to a digital value, and 
prints this value in both decimal and hexadecimal form on the computer screen.  The conversion is 
done using 12 bits of resolution in 2's complement form.  (It is assumed the student by now is 
familiar with 2's complement representation of voltages.)  Analog inputs in the ±10V range should be 
read correctly.  There are three A/D channels available on each computer bench. 
 



9 

/* Example Program to Read in a Value from A/D0 with lo & hi byte address @ 303 & 304 hex */ 
 
#include <stdio.h> 
 
main() 
{ 
 int *in0_ptr;  /* necessary to convert the two 8bits values read from chan. 0 to a 16bit 
integer */ 
 unsigned char inchan0[2];  /* to hold the two bytes read from the channel 0 input port */ 
 
 in0_ptr = (int *)inchan0;  /* point integer pointer to the bytes read from channel 0 */ 
 
/* the addresses in hexadecimal between 0x300 and 0x310 map to the multifunction card registers */ 
 outp(0x301,0);   /* select A/D chan. 0 and set gain to 1 (default value) */ 
 outp(0x302,0);   /* start conversion on A/D 0 */ 
 while(!(inp(0x300)&0x40));  /* wait for completion of conversion */ 
 
/* 0x303 and 0x304 are the addresses of the A/D converter input */ 
 inchan0[0] = inp(0x303);  /* read the low byte of the digitally converted voltage */ 
 inchan0[1] = inp(0x304);  /* read the 4 remaining bits (high byte) of the voltage (12bit 
A/D */ 
 
 printf("i=%d decimal and %03x hexadecimal \n", *in0_ptr, *in0_ptr); 
} 
 
 
• D/A Converter.  This provides a fully interfaced conversion of digital data to a bipolar analog 
voltage with a resolution of 12 bits.  The digital data is taken to be in 2's complement form and the 
output has a range ±10V in 4.883 mvolt increments.  There are two D/A channels per bench. 
 
/* Sample Program to Output a Value.  The program will output 5.0 volts to the D/A: 
40016 * .004883 = 102410 * .004883 = 5.000V */ 

 
#include <stdio.h> 
 
main() 
{ 
 float v; 
 int *out0_ptr;  /* necessary to convert the 16bit integer to two 8bits values output to 
D/A */ 
 unsigned char outchan0[2];  /* to holds the two 8bit values to be written to chan. 0 D/A */ 
 
 out0_ptr = (int *)outchan0;   /* point integer pointer to the bytes to be written to chan. 0 */ 
 *out0_ptr = 0x400;   /* write 400 hex to the bytes of outchan0 array */ 
 
 outp(0x305, outchan0[0]);  /* output the low byte first to the chan. 0 D/A*/ 
 outp(0x306, outchan0[1]);  /* output the high byte to the chan. 0 D/A*/  
      /* 0x305 & 0x306 are addresses for D/A 0, low & high bytes */ 
      /* 0x307 & 0x308 are addresses for D/A 1, low & high bytes */ 
 v = *out0_ptr * 20.0 / 4096.0; /* res = range/2**12; voltage = N * res */ 
 printf("i=%d decimal and %03x hexadecimal \n", *out0_ptr, *out0_ptr); 
 printf("voltage=%12.8f volts \n", v); 
} 
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• Keyboard I/O.  The PC is equipped with a standard full 101 key keyboard that can be scanned 
and read under program control with or without echoing the character to the VGA display. 
 
/* Example Program to Read/Write to the Keyboard.  Getch is a very useful function.  It waits in a 
keyboard reading loop and leaves only after a key has been struck with the ASCII value of the key returned 
by the function.  */ 
 
#include <stdio.h> 
 
main() 
{ 
 int i,j; 
 printf("Hit a key on the keyboard \n"); 
 
 i=getch();   /* read in key hit */ 
 putch(i);  /* optional echo of character */ 
 printf("The character was %c with decimal ASCII value %d \n", i, i); 
} 
 
 
 
EXPERIMENTAL PROCEDURE 
 
 
PART I – PRE-PROGRAMMED FUNCTIONS 
 
 
 For this part of the procedure you will be observing several different Digital Signal Processing 
programs.  These are fully-developed canned programs stored in the INTRO directory for your use.  
They are listed below with their source code file name.  They may be executed directly by merely 
typing the name of the program (without the .suffix) at the DOS prompt or from within the QuickC 
environment by typing QC 'name' and hitting F5 once to compile and again to execute.  Ignore any 
compiler generated warnings (but not errors, which shouldn't exist if everything is working 
properly).  The programs should terminate by hitting a keyboard key.  Within QuickC, a new 
program may be loaded and executed by hitting the Alt key, the down arrow, and selecting the 
Open function with the cursor key.  Hit the TAB key to get to the list of source files and use the 
cursor keys to select the desired file.  Pressing RETURN will load in the selected file. 
 
 For each of the first 5 programs, you should be able to derive the difference equation 
by looking at the source listing and from that get a transfer function H(z), pole-zero plot, 
and magnitude plot of |H(ejω)| on the unit circle.  Make sure you understand the relationship 
among these different forms of each digital filter implementation. 
 
  PROGRAM     FILE NAME 
 
 1. Negative Signal Rectifier   NEGREC.C 
 2. Sum and Difference Extractor   SUMDIF.C 
 3. Digital Differentiator    DDIFFER.C 
 4. Digital Integrator    DINTEG.C 
 5. First Order Low Pass Filter   1STLPF.C 
 6. Variable Resolution and Sample Period VRESFRQ.C 
 7. Digital Voltmeter    DVOLTM.C 
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1.  This program will output the negative of the absolute value of the input samples. 
 

a) Put a sine wave on A/D 0 and observe the output on D/A 0.  Is it what you expected?  
Observe the effects of adding an offset to the signal with the offset adjustment on the signal 
generator. 
 
b) Repeat a) using triangle and square waves.  Sketch the input and output waveforms to scale 
and explain any salient points. 
 
c) What happens when the input exceeds the ±10. volt range of the converters. 

 
2.  The Sum and Difference Extractor takes two signals, one from A/D 0 and one from A/D 1, and 

output the sum on D/A 0 and the difference on D/A 1. 
 

a) Input several different signals and observe and sketch their outputs. 
 
b) What happens when the sum exceeds +10 volts or is less than -10 volts?  Explain this in 
terms of the bit values of the 2's complement form of the converters by performing the 
arithmetic manually and truncating the result to the 12 bits. 

 
3.  The Digital Differentiator simply calculates the difference between the values of the signal at 

time kT and (k-1)T and outputs this difference (scaled by a gain of 4).  The input goes to A/D 0 
and output appears on D/A 0. 
 
a) Look at sine, triangle, and square waves and draw graphs of the input and output signals 
noting amplitude and frequency and shape.  What happens when the frequency of the signal is 
increased?  Is this expected?  
 
b) What causes the stray samples at the edges of the square wave?  
 
c) Look at the source listing and find the difference equation for this filter.  Find the 
corresponding Z-transform transfer function H(z), and sketch the pole/zero diagram. 

 
4.  The Digital Integrator program simply adds the present input value to the sum of all past 

inputs and outputs this sum.   
 

a) What is the apparent problem with this program and how might you revise it to get around 
this problem?  Carefully adjust the DC offset on the input signal to obtain the best results.  
Look at sine, triangle, and square waves and verify the shape of the output waves and the 
effect of the frequency on the amplitude.  Note: Keeping the amplitude of the input signal 
around 1 volt or less will improve the stability of the output signal. 
 
b) Look at the program DINTEG0.C and observe its operation with sine, triangle and square 
waves over a range of frequencies.  Again keep the input signal amplitude small.  Does the 
filter work as a better integrator at high frequencies?  Why or why not?  What filter does it 
implement?  
 
c) Again, look at the source listing and find the difference equation for this filter.  Find the 
corresponding Z-transform transfer function H(z), and sketch the pole/zero diagram. 

 
5.  A simple First Order Low Pass Filter is implemented by a program that averages the current 

and previous input samples to produce the current output sample.  The Z-transform of the 

filter is 
(z +1)

2z
.  Find the difference equation from the transfer function and verify it by 
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looking at the program source listing. 
 

a) Where are the pole and zero on the unit circle of this filter?  Find the 3 dB frequency and the 
frequency where the output goes to zero.  Do these correspond correctly with the calculated 
values from the sample period of the program T measured with an oscilloscope?  Sketch the 

magnitude of the filter's response |H(ejω)| for 0≤ ω ≤ 
2π
T    and verify the filter's gain at 4 or 5 

different frequencies. 
 
b) What happens when the input frequency exceeds the Nyquist frequency?  Sketch the input 

and output waveforms for frequencies of 0, 
1
4  fsamp, 

3
8  fsamp, 

1
2  fsamp, 

5
8  fsamp, 

3
4  fsamp, fsamp, 

and 2fsamp. 
 
6.  This program samples an analog signal on A/D 0 with a variable sample frequency and bit 

resolution and outputs the result to D/A 0.  Initially the sample frequency is set to its 
maximum value and the resolution is set to the full 12 bits with a mask of FFF hex.  Once the 
program is started, it samples the input continuously and outputs the reconstructed wave on 
the D/A converter. 

 
The delay constant (d) is related to the sample period T by T=d*t+t0 where t is the delay loop 
time and t0 is the overhead delay time of the program.  To change the delay constant d, hit the 
Space bar and enter a value from 0 to 32767 followed by Return. 
 
The bit mask that can be used to reduce the effective resolution of the converter is displayed in 
both hexadecimal and binary.  Pressing any key <1> through <0>, <->, and <=> will toggle the 
corresponding bit in the mask.  Using the sequence for the mask, FFF, FFE, FFC, FF8, FF0, 
FE0, FC0, F80, F00, E00, C00, 800, and 000 one can see the number of (most) significant bits 
vary from the full 12 to 0, dropping the least significant bit each step.  In effect the resolution 
of the converter drops from 12 to 0 as the mask forces the corresponding bits of the digitized 
sample to zero. 
 
a) The effects on signal transmission characteristics caused by varying resolution and sample 
frequency will be studied.  Can one use any A/D and D/A converters to do a particular job?  
What is the maximum frequency that can be sampled by the PC with these converters?  How 
many bits are necessary to reconstruct a signal within a minimum acceptable error?  Does the 
frequency of the wave necessarily determine the number of bits?  
 
Connect the equipment as shown in FIG. 2.  Note that the point A, B, and C are locations 
where an oscilloscope may be connected to view the input signal, the quantized sampled signal, 
and the LPF reconstructed wave, respectively.  The low pass filter has a 3 dB point at about 
1000Hz.  What effect could this have on your results?  
 
b) Find the actual sample period T using the scope with different values of the sampling delay 
d and use a system of 2 equations in 2 unknowns to calculate t and t0 in the formula T=d*t+t0 
 
c) Try taking resolution bit out, both in sequence from least significant to most significant and 
in reverse sequence from most to least.  Also note the effect of taking bits out randomly.  Be 
sure you can explain and prove mathematically what is happening to the analog signal. 
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FIGURE 2.  Setup for the sampling program. 

 
d) (Optional thought question).  What kind of errors are found when one tries to read an 
analog value into a digital device?  Can one operate on these values and get reasonable 
results?  If so, by how much?  
 
You should tabulate result of a mean squared error analysis for different numbers of 
quantization levels at different frequencies (four or five frequencies spanning the transmission 
frequency band), with and without the low pass filter. 
 
As you try to sample higher frequencies or lower the sampling rate, the error rate jumps with 
both filtered and non-filtered signals.  Why?  Can you think of an easier way to find the mean 
squared error?  
 
You should vary the sample rate of a sine wave at a fixed frequency to find the minimum 
sampling frequency needed to: 
  i) Ensure good reconstruction of the input wave after the LPF. 
  ii) Evaluate the effect of the LPF bandwidth. 
  iii) Estimate the RMS error (Δ2/12) as a function of the number of levels.   
 
You may wish to use any spare time in analyzing different frequencies, as well as their 
relationship to the sampling frequency that is being used.  You should be able to answer the 
following questions even though the answers are not found explicitly in your work. 
  i) Why does the wave move?  Can this be corrected by the computer after  
  sampling?  How important is this?  Where may this become important?  
  ii) Can you find a phase shift?  What could cause one?  
  iii) Why is the digital-to-analog converter considered to have an analog output  
  when it can only assume discrete values depending upon the input?  

 
7.  This program acts as a digital voltmeter that displays the 12 bit digital value of the voltage in 

floating point volts as well a fixed point (bit value) decimal, hexadecimal, and binary.  A/D port 
0 is used to provide a signal to the program and D/A port 0 echoes out the digitized and 
reconverted analog voltage.  Again the allowable input voltage range is +10.00 volts.  With 12 
bits there are 4096 discrete steps and over the range from -10.0 to +10.0 volts, the resolution is 
20/4096 or .004 882 812 5 volts/bit.  This is probably too small to be measured accurately with 
one single step, but can be calculated by measuring the voltage change over several hundred 
steps.  You should take data with a voltmeter to compare values to those provided by the 
program and be able to verify the two's complement notation representation in both binary and 
hex to the decimal value and the reading from the voltmeter. 
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a) Connect the variable voltage source to both the input port and the oscilloscope.  Connect the 
output port to the scope also and provide a way of taking measurements with the voltmeter on 
both the input and output ports. 
 
b) Take readings of all four numbers on the display as well as from the voltmeter on the input 
and output for several voltage levels from the source from -10.0 to +10.0 volts.  Note especially 
what happens when you go slightly below -10.0 or slightly above +10.0 volts, and from slightly 
below to slightly above 0.0 volts.  Be sure you can convert directly and verify among the 
various forms representing the digitized voltage of decimal, hex, binary, and the floating point 
notation in volts. 

 
 
PART II – USER-WRITTEN FUNCTIONS 
 
 For this part of the experiment you are expected to write a few simple programs using the I/O 
features available such as the keyboard, VGA display, D/A and A/D converters.  Using the 
techniques outlined under the INTRODUCTION TO PROGRAMMING WITH MICROSOFT QuickC 
part and the program examples using I/O devices in the same section, you should have little trouble 
writing some simple programs.  Listed below are several suggested problems for which you may try 
to write program solutions.  Choose a few that look interesting to you.  The previous examples should 
prove valuable here and will give you a basic understanding of programming the PC in C.  For all 
programs, explain how they work in the write-up and include a copy of the program source code. 
 
1.  Program Examples.  To help you get started, here are a few simpler programs that you may 

want to enter and run to gain some experience.  You may also look at the source code files of 
any of the pre-written programs run in Part A.  and print out copies for your use. 

 
 a) This program outputs a sawtooth wave on D/A 0.  Hit CTRL-BREAK to terminate. 
 
main() 
{ 
 int *out0_ptr; /* necessary for converting the 16bit integer into two 8bits values to be written 
to       chan. D/A 0 */ 
 unsigned char outchan0[2]; /* to holds the two 8bit values to be written to chan. D/A 0 */ 
 
 out0_ptr = (int *)outchan0; /* point the integer pointer to the bytes to be written to chan. 0 */ 
 *out0_ptr = 0; 
 
loop: *out0_ptr = *out0_ptr + 8; /* increment by 8 (by 1 is very slow) */ 
 outp(0x305, outchan0[0]);  /* output the low byte first to the chan. D/A 0 */ 
 outp(0x306, outchan0[1]); /* output the high byte to the chan. D/A 0 */  
 goto loop; 
} 
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b) This program uses some of the techniques described earlier.  It blanks the display, outputs a 
message, reads a decimal integer from the keyboard, displays the hexadecimal value on the 
VGA display, and outputs a voltage corresponding to the 12 bits of the integer. 

 
#include <stdio.h> 
#include <graph.h> 
 
main() 
{ 
 int *out0_ptr; /* necessary for converting the 16bit integer into two 8bits values to be written 
to       chan. D/A 0 */ 
 unsigned char outchan0[2];  /* to holds the two 8bit values to be written to chan. D/A 0 */ 
 
 out0_ptr = (int *)outchan0; 
 _clearscreen(_GCLEARSCREEN);  /* clear the screen */ 
 
loop: _settextposition(8, 8);  /* position the cursor at row 8, column 8 */ 
 printf(" Enter decimal integer (-2048:2047) followed by <return>:"); 
 scanf("%d", out0_ptr);   /* read in an integer value from the keyboard */ 
 _settextposition(10, 10); 
 printf("The integer %6d in hex is %03x  ", *out0_ptr, *out0_ptr); 
 
 outp(0x305, outchan0[0]);   /* output the low byte first to the chan. D/A 0 */ 
 outp(0x306, outchan0[1]);  /* output the high byte to the chan. D/A 0 */  
 goto loop; 
} 
 
 
 
2.  Write a program to read an integer from the keyboard and output to D/A 0 the sum of the 

integer and the voltage read in from A/D 0.  This value should also be displayed on the VGA 
monitor in decimal and hex.  Write the program so that it assumes the integer will be in 2's 
complement form. 

 
  The C statement if(!kbhit())goto label; can be used by a program to check if a key has been 

hit.  Execution can continue from label: if it hasn't been hit rather than pausing the program 
and waiting for a hit. 

 
  After the program is running try the following: 
  a) Ground the A/D input, type in 4096, and observe the voltage. 
 
  b) Do the same with -4096. 
 
  c) Observe what happens when the integer offset gets too large.  Explain the results. 
 
  d) Observe what happens when the offset is fixed but the analog input exceeds +10 volts. 
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3.  Choose values for V1 and/or V2 and write a program that will generate one or more of the 

following waveshapes.  The exact frequency of the wave is not important. 
 
 

 
 
 

FIGURE 3.  Example 3. waveshapes. 
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4.  Choose values for V1 and/or V2 and write a program that will take the given input signal from 

one of the A/D ports and process it to give the desired output on one of the D/A ports (N equals 
2, 3, 4, or 5).  HINT: To multiply a positive input by 2, shift it left one place.  To multiply by 3, 
shift left and add it to the original input. 

 
 

FIGURE 4.  Example 4. waveshapes. 
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5.  Write a variable time delay subroutine and use it to generate a square wave with a specified 
frequency and duty cycle. 

 
6.  Write a program to compute output z: 

   z =
|w | ! | y |   if  | w |>| y |

0               if  | w |<| y |

" 
# 
$ 

 

 
where w and y will be input in 2's complement form and read by the program from the A/D 
converters. 

 
7.  Write a program that will read a keyboard digit (0-9) and output the character in the column 

on the monitor corresponding to the value. 
 
8.  Make a copy of the program 1STLPF.C and modify the copy to implement a High Pass Filter 

whose function is
(z !1)

2z
.  Where on the unit circle are the pole and zero of this filter?  Find 

the 3dB frequency, and the frequency where the output goes to zero.  Compare the filter's 
response to that of the original filter in 1STLPF.C. 

 
9.  If you have any specific ideas in the way of a program function, ask the lab instructor and have 

it approved before implementing it.  You may use any and all of the subroutines provided for 
your convenience. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
NOTE: 
 
The procedure to boot the PC without Windows running in the background must be used every time 
the computer is used for real-time control applications in the Computer Applications Lab 
experiments.  Repeating again here as a reference, remember to restart the PC, if it is currently 
running Windows or off.  While it is booting up – just after the ‘Starting Windows 95’ message, hit 
the <F8> key.  Choose ‘COMMAND PROMPT ONLY” (option 6) in the list.  At the DOS prompt type: 
CD C:\Cstudio\CAL_LAB.  A ‘dir’ command will give you a list of available directories for the 
different experiments to which you can move to run the necessary executable programs. 
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#include <stdio.h> 
#include <graph.h> 
 
main() 
{ 
 
 int i,j,k,l,a,b; 
 unsigned char *i1,*i0,*j1,*j0,*k1,*k0,*l1,*l0; 
 
 i0=&i; i1=i0+1; /* set i1 & i0 to the high & low bytes of i */ 
 j0=&j; j1=j0+1; /* ditto for j0 & j1 */ 
 k0=&k; k1=k0+1; /* set k1 & k0 to the high & low bytes of k */ 
 l0=&l; l1=l0+1; /* ditto for l0 & l1 */ 
 
 _clearscreen(_GCLEARSCREEN); 
 printf(" Sum and Difference Program: hit any key to terminate. \n\n\n\r"); 
 printf("The analog signals input to A/D 0 and A/D 1 are combined to produce 
\n\r"); 
 printf("two output signals.  D/A 0 outputs the sum of the 2 signals and \n\r"); 
 printf("D/A 1 outputs the difference A/D 0 - A/D 1. \n\r"); 
 
loop: outp(0x301,0);  /* select A/D ch. 0, set gain to 1 */ 
 outp(0x302,0);  /* start conversion */ 
 outp(0x305,*k0); outp(0x306,*k1);  /* output last value     */ 
 while(!(inp(0x300) & 0x40)); 
 *i0=inp(0x303); *i1=inp(0x304);     /* input voltage        */ 
 
 outp(0x301,1);  /* select A/D ch. 1, set gain to 1 */ 
 outp(0x302,0);  /* start conversion */ 
 outp(0x307,*l0); outp(0x308,*l1);  /* output last value     */ 
 while(!(inp(0x300) & 0x40)); 
 *j0=inp(0x303); *j1=inp(0x304);     /* input voltage        */ 
 
 k=i+j; 
 l=i-j; 
 
/*      printf(" %d ",j); */ 
 
 if(!kbhit())goto loop; 
} 

 
 
 
 
 
 
 
 
 
 
This listing of the file SUMDIF.C is included in case the file available in the INTRO directory is an 
older version that does not run correctly on faster PCs. Note the two 'while' statements before the 
'inp()' lines and make changes to the source on the PC before executing the program. 


